Short Question Answers

What is a computer? What are functions of a computer?

A Computer is a device or machine that receives data from user, performs the sequences of operation based
on the data and gives out meaningful result.

Functions of computer are

e Input: To accept raw data from user
e Processing: To perform operator on data
e Output: To produce result (information)
e Storage: To save data for future use

[Note: computer P gy T HTH ﬁtﬂ input, processing ¥ output Cal P I TR A& ]

Write down advantages and disadvantages of computer.
Advantages of computer

High Speed : computer performs operations very fast

Accuracy: Computer gives out accurate result if the input is correct

Storage capacity: Computer can store large amount of data

Diligence: Computer can perform same task repeatedly with the same speed and accuracy
Versatility: Computer is flexible and can be used to perform different kinds of tasks
Reliability: Information produced by computer is reliable

Automation: Computer performs given task automatically

[What are the features of computer HI uf~ Id SR a@ ]

Disadvantages of computer

[Disadvantages SBT3 HA faRId aoaTe g1 gHIgs a=A 1]

e Unemployment: computer reduces manpower

Data security: data can be accessed by unauthorized person

computer crimes: people can use computer for criminal activities

Privacy risk: If data are not protected personal data can be leaked

Health risk: Working in computer for long time can damage eye and can cause back pain
Wastage of time: doing unwanted activities wastes time

Limitation of computer =T 4 TADT JGT8% A&

o Computer has no feeling.

Computer cannot think of its own

Computer cannot perform tasks on its own

It is depended on human input

It provides accurate result only if the input is correct

Discuss the application of computers in various sectors.

Computer is versatile machine. It can be used for various purpose in different sectors. Some of the sectors
computers are used are

Business

Computers can be used for Payroll calculations, Budgeting, Sales analysis, Financial forecasting, Managing
employee database, Maintenance of stocks, etc.



Banking

In banking computers are used for Online accounting facility. Computer is also used in ATM machine
Education

Computers help in teaching with CBE (Computer Based Education) and also help in distance learning
Marketing

Computers are used for Advertising and Home Shopping

Health

Computers can be used for diagnostic and treatment and also for surgery

Engineering

In engineering, it can be used in CAD (Computer Aided Design)

Military

Computers can be used for defense in military

Communication

E-mail, Chatting, FTP, Telnet, Video-conferencing are done with the help of computers

Government

Computers are essential for e-governance

Entertainment

People get entertainment from computer game, movies and cartoons

What do you understand by computer generation ? Discuss

different generations of computer.

Classification of computers in different time-frame based on their technological development is known as
generation of computers. There are five generations of computers so far.

First Generation Computers

¢ Electronic device: Vacuum Tube

Size: Large, Bulky

Speed: Very Slow

Consumes lot of electricity

E.g. ENIAC, EDSAC, EDVAC, UNIVAC, IBM-650, 702, 705

Second Generation Computer

e Electronic device: Transistor

e Size: Smaller than first generation

e Speed: Faster (could perform task in microseconds)
e E.g. IBM 7000, ATLAS, MARK-III, Honeywell-200

Third Generation Computer

e Electronic device: IC (Integrated Circuits)

Input: Punched Card, Keyboard

Size: Smaller than second generation computers

Speed: faster than second generation computer (could perform tasks in nanosecond)
Used operating system

E.g. IBM 360, ICL 2900

Fourth Generation Computer

e Electronic device: Microprocessor

e Size: Small than third generation computer

e Speed: faster than third generation computer (could perform task in picoseconds)
e E.g. Pentium Series computers, IBM System/370, HP-3000, AMD Athelon

Fifth Generation Computer

e Will be based on biochips



e Will have artificial intelligence
e Will have ability to solve problem themselves

Explain types of computer in short.
Types of computer can be discussed under different categories
BASED ON FUNCTION

1. Analog:

e Measures physical quantity like temperature, pressure, speed
e Operations are performed in parallel
e e.g of analog devices: speedometer, thermometer

2. Digital:

e works on the basis of digits
e operations are performed in sequence
e c.g. calculator and all modern computer

3. Hybrid

e Having the capabilities of both analog and digital computers
e E.g. ECG(Electrocardiogram), CT-Scan

Based on size and speed
1. Microcomputer

¢ Single user computer known as personal computer (PC)
e Used in home, office, schools etc

e Limited speed

e Desktops and laptops

2. Minicomputer

e Multiuser computer (more than 100 users can users at a time)
e Bigger than microcomputer
e Faster than microcomputer

3. Mainframe Computer

e Multiuser computer (more than 1000 users can use at a time)
Bigger than minicomputer

Faster than minicomputer

Used in centralized databases and WAN

E.g. DEC, ICL, IBM 370

4. Super Computer

e Fastest, Most Powerful and Most Expensive

e Used for weather forecasting, , remote sensing, aircraft design, large amount of number calculation
(number crunching)

e E.g. CRY XMP, CRAY2

Based on Brand

1. IBM Personal Computer

Computers manufactured by IBM (International Business Machine) Company

2. IBM Compatible Computer

Computers manufactured by other companies (except APPLE Company) with the design and architecture of
IBM

3. Apple/Macintosh Computer



Computers manufactured by Apple company with own design and architecture
Based on model
1. XT Computer (Extended Technology):

¢ Does not support GUI based OS
e Processing speed 4.77 Mhz
e E.g. Intel 8080, 8086, 8088

2. AT Computer (Advanced Technology)

e Supports GUI based OS
e Processing speed 2 Ghz
e E.g. Intel Pentium series

3. PS/2 Computer

e Refinement of AT computers
e Mostly used in Laptops

What are the basic components of a computer? Explain

Basic Components of Computer are Input Unit, Processing Unit, Output Unit and Memory Unit
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Input Unit: Devices which are used to feed data into computer are input unit. E.g. Mouse, Keyboard,
Scanner, Microphone etc.

Processing Unit: It is also known as CPU (Central Processing Unit) that performs all the processing of
computer and it is connectec to motherboard. It is combination of Arithmetic Logic Unit, CU Control Unit
and Registers (Memory)

Output Unit: Devices which give result in human understandable form after processing are output unit. E.g.
Monitor, Printer, Speaker, Projector etc.

Memory Unit: Memory unit saves data or instructions either temporarily or permanentaly

What is CPU ? How does it work?

CPU is also called brain of computer. It performs all the processing tasks of computer. CPU itself has
following three components.

ALU(Arithmetic Logic Unit):

ALU of Computer performs operations to execute the programs

It is responsible for all arithmetic calculations like addition, subtraction, multiplication, and division. It also
performs logical operations such as comparing, selecting, and matching.

Control Unit

e [t controls the operations of all parts of the computer but does not take part in actual data processing
operations. Functions of control unit are

To control transfer of data and instructions among other units of a computer

to manage and coordinates all the units of the computer

to receive the instructions from the memory, interprets them

to communicates with Input/output devices

Registers
Registers are known memory of CPU. This unit stores intermediate results of processing.It stores the final
results before these results are released to an output device.

What are the functions of input devices give some examples.

Function of input devices is to feed data into computer. They give instructions to computer in computer
understandable form. Some important input devices are. Keyboard, Mouse, Microphone, MICR, OCR, BCR
are examples of input derives.

Keyboard: Keyboard is the most common inpout device that is used to enter textutal data and also to type



executable commands
Mouse: Mouse is pointing devices that makes user easier to execute commands vie buttons
Microphone: used to input voice data by recording sound

Explain different types of printers with examples

Based on printing mechanism printers are divided into two types

Impact Printer: The printer where printer head or printing mechanism touches the paper. These printers
make noise. Printing quality of impact is low. Printing speed is slow. Dot Matrix Printer, Daisy Wheel Printer
are example of Impact Printer

Non Impact Printer: The printer where printer head or printing mechanism does not touch the paper. These
printers make less noise. Printing quality of impact is high. Printing speed is faster.

What are two basic types of memory? Explain with examples
Memory are the storage area of computer. Where data are stored temporarily or permanently
Two basic types of memory are Primary Memory and Secondary Memory

Primary Memory:

e Also known as internal or main memory
e Stores data or instructions for short period
e Further can be divided into RAM and ROM

Secondary Memory

e Also known as external or auxiliary memory
e Stores data for future use
e Can be classified into Magnetic like Harddisk and Optical media like CD, DVD

Write on: Cache Memory and Virtual Memory

Cache memory

Cache memory is very high speed memory that is placed between processor and main memory. It is used to
manage difference in speed of CPU and main memory and to reduce average time to access data from main
memory
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Virtual Memory

It is not real memory. Virtual memory is a memory management technique that allows using secondary
memory as main memory when main memory is not enough to execute certain task in computer.

Differentiate:
a. Primary Memory and Secondary Memory
b. RAM and ROM

Primary Memory Secondary Memory

1. These are semiconductor memories 1. These are magnetic and optical memories.

2. known as the main memory or internal memory 2. known as auxiliary memory or external memory
3. Volatile 3. Non Volatile

4. Saves data temporarily. So, known as working 4. Saved data permanently. So used for backup
[memory 5. Computer can work in the absence of secondary
5. A computer cannot be run without the primary ~ jmemory

[memory 6. Slower

6. Faster e.g. Hard Disk, CD/ DVD

e.g. RAM, ROM




RAM ROM

1. Temporary in Nature 1. Permanent in Nature

2. Read/Write Memory, also known as working 2. Read Only Memory

jmemory 3. Non volatile

3. Volatile 4. More reliable

4. Less reliable 5. Basic Types: PROM, EPROM, EEPROM

5. Basic Types: SRAM, DRAM

Based on access what are the types of storage (memory) ?
There are two type storage (memory) based in access method

e Sequential Access Memory

- Access time depends on the location of the data
- Slower
- E.g. Magnetic Tape

e Random Access Memory

- Access time does not depend on the location of data

- Faster
- E.g. Magnetic disk (Hard Disk), Semiconductor (RAM), optical disk (CD/DVD)

Define hardware and software with examples.

Hardware
Software
Physical parts of computer Set of programs
Can be seen, felt and touched Cannot be seen, felt and touched
Base for software Needs hardware to use
E.g. Input (keyboard), Output (monitor), Processing |e.g. System Software, Application Software
Unit (CPU)

What are the types of software?

There are basically two types of software which can be further divided into different types
1. System Software

- Software handles the computer system

Types of system software

a. Operating System Software

- Software that is needed to operator or start computer



- e.g. Windows

b. Utilities

- Software that help to configure, optimize and maintain the computer system
- e.g. Antivirus Software

¢. Device Driver

- Software that controls and operator hardware or peripheral devices attached to commputer system
- e.g. Audio driver, Network driver

2. Application software

software that is used to perform different tasks

a. Packaged Software

- Readymade software

- Designed for public use

- E.g. Graphic Software, Multimedia Software, Database software

b. Tailored Software

- Customized software

- Designed for private/ personal use

- E.g. MIS Software, Billing software

What is programming language? Write about different types of

programming language?

A programming language is a set of rules to instruct a computer to perform specific tasks. There are two
basic types of programming languages:

a. Low Level Language: Machine dependent language

Machine Language:

e 1st Generation Language.

e Usesonly 0 and 1.

¢ Understood by computer, difficult to understand by human
e No need to translate

Assembly Language:

¢ 2nd Generation Language

e Uses mnemonic (symbols)

e Not understood by computer
e Needs to translate

b. High Level Language: Machine independent language

¢ 3rd Generation Language

Uses English words and phrases

Not understood by computer. Easy to understand by human
Needs to translate

e.g. C language, Java, C++ etc. are high level language

What is language processor? Differentiate interpreter and

compiler?
A language processor is language translator that converts program written in assembly language or high level
language into machine language.

Interpreter

|Compiler
1. Translates one statement at a time. 1. Translates whole program at a time.
2. Execution is slower 2. Execution is faster




3. Does not create object code 3. Creates object code
4. Programming language like Python, Ruby use 4. Programming language like C, C++ use compilers
interpreters

What is computer network? What are the advantages of computer
network?

Computer network is an interconnection of two or more computers with wire or wireless medium to share
data and resources.

LS

Advantages of computer network are:

a. Sharing of data and resources: data and resoureces can be shared easily

b. Increased storage capacity: storage capacity is increased by combine the capacity of all the computers in
network

c. Easy access to data: data can be accessed anytime from any computers in network

Explain different types of network.

Network can be classified into different categories

1. Based on Architecture

a. Client Server: Where one main computer works as server and other comptuers are served as client

l#.client server
b. Peer to Peer: Same computer can behave as server and client both

le.peer

c¢. Hybrid: Combination of Client server and Peer to Peer computers

2. Based on Geographic Distribution

a. Local Area Network: Covers limited area

b. Metropolitan Area Network: Covers larger area than LAN upto the city
c. Wide Area Network: Can spread worldwide.

What are the basic components of computer network? Explain any

five.

Basic components of computer network are:
a. Server: Powerful computer in network which controls other computers are called sever

le.client server

b. Workstation: Workstations are computers which are connected to server

c. Network Operating System: Operating system software used in server computer is called network
operating system

d. Network Interface card: It is a device which is used to establish physical connection between computers
in network

e. Transmission media: It is the medium through which data are transferred among the computers in
network. It can be guided (wired) or unguided (wireless)

f. Network Device: Devices like modem, hub, switch, router, repeater, bridge, gateway are called
networking device

Differentiate between: hub and switch, switch and router

[#.hub switch

[



What do you understand by computer security? Explain

Computer security means protecting computer from accidental or intentional harm. There are 3 aspects of
computer security:

1. Confidentiality: Information should be available only to authorized user should not be available to
wrong person. This is possible by using username and password

2. Integrity: Information should not be modified by unauthorized access. Receiver should receive the
information exactly as it was sent by sender.

3. Availability: Information should be available completely whenever it is required by the authorized
user.

Computer Security deals with hardware security and software security
Hardware Security Measures

hardware STRTTGH Prle é@]

Regular Maintenance

Insurance

Dust free environment

Protection from fire

Building construction

Protection from theft

Power protection devices (UPS, Volt Guard)
Air conditioner System

Access Control

Software Security Measures [software d[ data SIUIRE (‘IROPIE% @@]

Password Protection

Backup System

Avoid pirated software

Use of anti-virus software
Use of anti-spyware soft.
Use scandisk, CHKDSK and
defragmentation tool

What are advantages and disadvantages of internet?
[Internet hT WIgal X CLAEAED PRI common sense NESIREY PRleE évg “€|ﬁ7_'i§]

Internet is the largest global public network. It is useful for human but it has some disadvantages also
Advantages

¢ Resources of information, knowledge and learning: Internet is huge source of data from where we
can get information about anything

e Data sharing: data sharing among the computers world wide is possible through internet

E-commerce: it is possible to buy and get goods through internet (online shopping) and fund transfer

is also possible through internet (online banking)

Source of earning: we can work from home and earn money using intertainment

Entertainment

Social connection

Marketing

Disadvantages

e Viruses: virus can spread into computer internet by visiting unsecure websites

Security Problem: if data is not secured they can be hacked

Filtration of information

Time consuming: there are lots of information in internet. It will take time to find exact information
Privacy leakage



e Language problem

[marks 1 STYRHT ST 7| $ g8 I 91 BIgal a1 ShIsal D! © Y- §AMH T+ U ] THT g3 oI
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What is network topology? What are its types?

Network topology can be layout or structure or design of computer network. Following are the types of
network topologies

Bus Topology

All devices are connected to a central cable, called the bus or backbone.

a1

Star Topology

All devices are connected to a central hub. Nodes communicate across the network by passing data through
the hub.

L6

Ring Topology

All devices are connected to one another in the shape of a closed loop, so that each device is connected
directly to two other devices, one on either side of it.

3

Mesh Topology

Devices are connected with many redundant interconnections between network nodes. In a true mesh
topology every node has a connection to every other node in the network.

2

Hybrid Topology

Combination of any two topologies.

Tree Topology

A hybrid topology of bus and start topology where groups of star-configured networks are connected to a
linear bus backbone.
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What is protocol? Give some examples.

Protocols are standards or rules that controls communication within a network.

Types of Protocol

TCP/IP (Transmission Control Protocol/ Internet Protocol): It is the most commonly used protocol over
internet.

HTTP (Hyper Text Transfer Protocol): It is the rules for transferring multimedia files (text, sound, image,
video, animation) on the Word Wide Web.

FTP (File Transfer Protocol): It is the protocol used to transfer data from a particular computer to another
over world wide web.

SMTP (Simple Mail Transfer Protocol): Protocol used for sending mail.

POP: Post Office Protocol for receiving e-mail

TELNET: It is a user command underlying TCP/IP protocol for accessing remote computer.

What do you mean by internet, intranet and extranet?

Internet

Internet is the largest public global network that connects millions of computer networks all over the world.
So, it is known as network of networks.

Intranet

An intranet is a private network that allows employees and staff in a company to securely share knowledge
and information easily within the company or organization. Intranets are typically limited to one organization
or site with little or no access to outside users (general public).



Extranet

A private network that is extended to users outside the company which share information with suppliers,
vendors, partners, customers, or other businesses. An extranet is often considered part of a company's
intranet that is extended to authorized users outside of the organization. It is based on internet.

(a1

What is computer virus? Write causes and symptoms of computer

virus.

A computer virus is a malicious software that destroys or damages the data, information and programs
residing in the computer system.

causes to spread virus

[P HYCHT virus Hid’)l PRUGE ]

1. Using pirated software

2. Sharing portable disk among the computers.

3. Downloading files/programs from unsecured sites.

4. Exchanging of data or files over a network.

5. Opening virus infected email or attachments without scanning

Symptoms of computer virus
[virus TS BTSN & G- HYAT HIGCRHAT virus THD! HIR] UTET §7O |
. Programs take long time to load.
. Computer is slower than normal.
. Computer stops responding.
. Disks or disk drives are inaccessible.
. Corrupts the system’s file and data.
. Programs open automatically without instruction.
. Renames files
. Changing in the size of files.
. Appearing of unusual error message
10. Restarts or shutdown automatically.
11. Programs disappear from computer.
12. Antivirus programs get disabled.
13. Errors occur in printing.
14. Generation of files and folders automatically.
15. Duplication of files.
16. Decrease disk space
17 Home Page Redirection
8. Decrease in download speed

[@fﬂ%@@l@ﬂﬁ%—ﬂ | TS Oeq Ui 818 | general@‘[@l@a ]
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. Install Internet Security Software like firewall

. Stop using pirated software

. Use updated antivirus software scan computer regularly

. Use password to protect computer from unauthorized users
. Do not open suspicious email attachment

. Scan portable disk before opening it

. Always maintain proper back up system

. Do not download from unsecured sites

O 001N N K~ W —
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Write about 5 types of computer virus. Also mention the ways to
protect computer from viruses



1. Boot Sector Virus: It infects the boot sector or Master Boot Record (MBR) of the disk.
2. Script Virus: Infects programs written in high level scripting languages like Visual Basic Script and
JavaScriptMacro Virus

. Multipartite Virus

. Stealth Virus: It hides itself while scanning and antivirus can not detect it.

. Polymorphic and

. Metamorphic Virus

. Resident Virus

. Web Scripting Virus: Resides in webpage file

. File Infector Virus

10. System Infector Virus

11. Application Infector Virus

12. Message Carrying Virus: Displays unwanted messages

[ATTT qed & 9T o]
What is cyber law ? What does it deal with?

Cyber Law is the rules and regulation (law) adopted by any government or organizations to control and
minimize the computer crime.
It deals with

O 003N L kA~ W

e Intellectual Property Right
Privacy and Data protection
Computer (Cyber) Crime
Digital Signature system
Freedom of expression
Electronic Transaction Act
Telecommunication Law

A. Intellectual Property Right (IPR)
It is the right /law to preserve the intellectual property of individuals like artists, authors, musicians etc.
It includes:

o Copyrights
o Patent Rights
o Trademark

B. Cyber Crime
Any criminal activity that uses a computer or network as source, tool, target or place of a crime. it includes

Unauthorized access and modification of hardware and software
Unauthorized release of information

Unauthorized copying of software

Using computer to facilitate illegal work

O 0O O ©o

C. Digital Signature
A digital signature is a mathematical scheme for that is used for authentication of digital message or doument

[marks R UL B | o 99 TI_jI T& | @R what is intellectual property right, what I cyber crime YR EE
J& T ATTAT Wig! 3TIR answer & 1]

Write definition and use of multimedia.

Multimedia is a form of communication combining with different media and they may include text, audio,
music, images, animation and video.
For e.g.

e Multimedia presentation
¢ Presentation of audio and video clips
e Multimedia software



¢ Educational software that involves animation, sound and text

Uses of multimedia
Multimedia can be used in different sectors

e Multimedia in Education:
- Distance Education, CD of study materials
e Multimedia in Training
- Training with the use of slide show, projector
e Multimedia in Entertainment
- Films, Video Clips, Games
e Multimedia in Advertisement
- Advertisements of business organization
e Multimedia in Presentation
- PowerPoint presentation on any topic
e Multimedia in Business Communication
- Customer Information, Notice of new product
e Multimedia in Web Page Designing

- Web sites with graphs, color, sounds

[Advantages of multimedia HI oy @'IT’I'I_Sc JHTAR TR A ]

Explain SDLC.

SDLC or the Software Development Life Cycle is a process that produces software with the highest quality
and lowest cost in the shortest time. SDLC includes a detailed plan for how to develop, alter, maintain, and
replace a software system.

different steps in SDLC are as follows:

[s.sdlc

1. Defining the problem/Planning: to find out the problem

2. Analyzing the solution: to find out way to solve the problem

3. Designing the solution: to design the solution with different designing tools like algorithm and flowchart
4. Coding/Developing: to code the program

5. Testing and debugging: to test the program and remove the errors

6. Implementation: to implement the program for practical use

7. Review and maintenance: to review the program for further modification

Y ﬁ"T algorithm X flowchart LG %ﬁ@?ﬂ |

What is logic gate? Explain its types.

A logic gate is an elementary building block of a digital circuit. There are seven basic logic gates: AND, OR,
XOR, NOT, NAND, NOR, and XNOR.

Each logic gate has two inputs (except NOT gate) A and B, which can either be 1 (True) or 0 (False). The
resulting output is a single value of 1 if the result is true, or 0 if the result is false.



o AND - True if A and B are both True

L
o OR - True if either A or B are True
lwor

o NOT - Inverts value: True if input is False; False if input is True
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o XOR - True if either A or B are True, but False if both are True

i’.aJ9

o NAND - AND followed by NOT: False only if A and B are both True

5

o NOR - OR followed by NOT: True only if A and B are both False

.0

o XNOR - XOR followed by NOT: True if A and B are both True or both False

i’.aJ8

What do you mean by IP Address? Write about different classes
of IP Address

IP address is logical address of computer. IP Version 4 uses 32 bits. [P Version 6 uses 128 bits.

w2

Total IP address range is divided into 5 classes:
Class A, Class B, Class C, Class D and Class E, while only A, B, and C are commonly used. Each
class allows for a range of valid IP addresses, shown in the following table.
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What is operating system ? What are its types?

An operating system (OS) is a software that controls the overall operations of computer system. It
controls and directs the flow of data and instructions from one part of computer to another. An
operating system acts a mediator between user and computer hardware. It provides interface to
computer user and platform to other programs.

Basic types of Operating system are:

Based on Interface:

o CLI (Character Line Interface): Work with commands
o GUI (Graphic User Interface): Windows with graphic and symbols

Based on User:

o Single User: It can be used by single user at a time. E.g. Windows



o Multiuser: It allows two or more users to run programs at a time. It is also known as Time
Sharing OS. E.g. Unix, Linux

Based on operation:

o Single Task: Allows to run only one program at a time. E.g.:DOS
o Multitask: Allows more than one program to run concurrently. E.g.:Windows

Some other types of os are

Embedded OS: Operating system that is self contained in the device and resident in ROM. Used in
ATM, Traffic

Networking OS: They are multi user, time sharing and multiprogramming operating system used for
server

Real-time: Responds to input instantly.

What are the functions of operating system?

[importance of operating system HI g ?ngf @@’]

that controls the overall operations of computer system. It controls and directs the flow of data and
instructions from one part of computer to another. An operating system acts a mediator between user
and computer hardware. It provides interface to computer user and platform to other programs. Other
functions of OS are

Process Management
Memory Management
File Management
Device Management
Security Management
User Interface

Job Management
Data Management
Controlling Resources
Program execution
I/O operations

File System manipulation
Communication

Error Detection
Resource Allocation
Protection

O 0O 0O OO O OO0 OO OO 0O 0 ©O

Define: file, folder, window, icon, taskbar, desktop

File: Set of informations stored in a computer with a unique name is called a file. File name contains
two parts i.e. primary name and secondary name.

Folder: a folder is an object that can contain multiple documents. Folders are used to organize
information

Window: A rectangular area covered by any file, folder or program in computer screen is called a
window

Icon: Graphical symbol in computer that represents file, folder or program is known as icon
Taskbar: Bar located at the bottom of desktop is known as taskbar. It holds opened files, folders and
programs

Desktop: Entire area on the screen after computer is first logged in is known as desktop. Desktop
contains icons and taskbar.

Define multiprogramming, multitasking, multithreadig,
multiprocessing



Multiprogramming

Multiprogramming is concept that More than one task/program/job/process can reside into the main
memory at one point of time.

Since multiple programs are resident in the memory, as soon as the currently executing program
finishes its execution, the next program is dispatched for its consumption.

le.Description: Multiprogramming

Multiprocessing
When one system is connected to more than one processor to complete the the task, it is called as
multiprocessing systems.

le.Description: Multiprocessing

Multithreading

"Multithreading is a programming concept where a process is divided into a number of sub-processes
called as threads. Each thread is independent and has its own path of execution.

A thread is a light weight process.

l#.Description: Multithreading

Multitasking

Multitasking is the ability of an operating system to execute more than one task simultaneously on a
single processor machine.

Multiple jobs are executed by the CPU simultaneously by switching between them. The various job
can be accepted from same user or different users.

l#.Description: Multitasking

What is batch processing? What are its advantages?

Batch processing is the procedure by which computers automatically complete series (batches) of jobs
in sequential order with minimal or no human interaction.

Payroll and Statement of Bank are examples of batch processing

Advantages of batch processing

Repeated jobs are done fast.

No need special hardware .

Best for large organization.

Batch systems can work oftline also.

Sharing of batch system for multiple users.

The idle time batch system is very less.

You can assign specific time for the batch i.e. at night or any free time.
The batch systems can manage large repeated work easily.
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What is command? What are internal and external commands?

Command is an instruction that DOS and Windows execute from the command line or from within a
batch file that to perform any task in computer.

Internal Commands

The commands that are loaded in computer memory while booting computer are. Those are frequently
used commands, and are called resident commands. e.g.

CLS: to clear the screen

MD: to create a directory

CD: to change the diretory
RD: to remove empty directory
Copy Con: to create files

O 0O 0O 0O ©o



o Type: to view the conent of saved file
o Ren: to rename the name of file or directory
o Del: to delete the file

External Commands
These commands are not loaded while booting computer. They are not the part of command.com file.
They require external forces or program to run. e.g.

Chkdsk: to check hard disk for any errors
Defrag: to manage fragmented files

Tree: to display tree structure of any directory
Label: to give label name for any volume (drive)
Edit: to edit the content of any file

What do you mean file a file? What are types of file?

Set of informations stored in a computer with a unique name is called a file. File name contains
two parts i.e. primary name and secondary name. Following are the types of files.

= Data file: Collection of data that is used by computer program.

= Program file: Collection of instructions to perform specific task by computer

= Information file: collection of information produced by computer as output which can be
used by user for future reference.

= System file: Special program files needed to start or boot computer. They are:

MSDOS.SYS: It controls and provides OS interface

COMMAND.COM: 1t interprets the user command. It stores the commands needed to perform
different tasks.

10.5YS: It controls the input and output

What is booting? What is cold and warm booting?
Booting means starting computer. It is the process to load operating system and prepares the
computer for use. During the booting BIOS starts the POST (Power On Self Test) operation.
Types of Boot

= Cold Boot: Process of starting computer by pressing powre button (on/off switch).

= Warm Boot: Process of starting computer by pressing Reset button or by pressing
'Ctrl+Alt+Del' keys.

Write uses and syntax of commands: dir, copy con, md, type,
ren

= Dir: to create a directory
syntax: DIRS
= Copy Con: to create a file

syntax: Copy Con _ file name8
[after typing some text press 'Ctrl+Z' or 'F6' to save]

= MD: to create a directory
syntax: MD_name of directory 8
= Type: to view the content of file

syntax: Type _file name8



= Ren: to rename a file/directory

syntax: Ren _, Old name , New name8

What do you mean by wildcard? What are the types of wild
card in DOS?

Wildcards can be used to specity a group of files.

+r1: read only attribute

+s: system attribute

+h: hide attribute

+a: archive attribute

There are two types of wildcards used in DOS

The asterisk ( *)

The asterisk represents any number of unknown characters. Use it when searching for
documents or files for which you have only partial names.

The question mark ( ?)

The question mark represents only one unknown character. Use it when you have a list of files
with very similar names, or when you are unsure of a few characters.

What is a window in Windows Operating System? Mention
its types.

A windows is a rectangular area covered by any file, folder or program in computer screen.

1. Application window/ Parent window: It displays the executable program. An application
window an be opened, closed, resized and moved around the desktop. The title bar appears on
the top of the application window. A program has only one application window. Press 'Alt+F4'
to close application window.

2. Doument window/ Child window: It appears inside the application window. A document
window is the area where we work. An application can have more than one document window.
Press 'Ctrl+W' to close document window.

What is Word Processing? What is the use of ms word?

Word processing describes the process of creating or editing a document. word processing or
word processor software enables us to write text, store it electronically, display it on a screen,
modify it and print it.

uses of ms word are:

- to create notebooks, assignments

- to create reports,blog post

- to create resume

- to create appliation, letter

- to create artiles, newsletters

- to create bibliography

- to check spelling and grammatical errors

- to draw shapes

- to create question papers

- to type equations

Features of ms word HT Uf~l T @Qlcﬂ‘.’: I T s |
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- mail merge
- hyperlink

- smart art

- bookmark
- index



- bibliography
- header and footers

- watermark HT%

What is formatting? What is different between text

formatting and paragraph formatting?

Formatting means appearanc or presentation of text in document. Formatting makes document
more attractive and readable.

Text formatting is changing text style. Text formatting includes
- Bold

- Italic

- Underline

- Changing font, font size and effects

Paragraph formatting is applied to paragraph which includes

- alignment (left, center, right, justify)

- Indentation

- line and paragraph spacing

- tab

Write the function of Save and Save As?

Save: This command is used to save document for first time. It also ussed to save the document
later after editing without changing file name, location and file format. Shortcut of save in ms
word is 'Ctrl +S'. We aso

Save as: This command is used to save already document with another format, another location
or another name. We have opened a document in desktop and if we want to save the document in
pdf or we want to save in drive d: then we use save as command.

What are settings need to set in computer before typing in
Nepali.

Basically while typing Nepali non-unicode font we face two problems: first letter automatically
becomes half and ' symbols turns to ‘ symbol. To avoid this problem we follow the given steps
> Click 'office button'

> Click "Word options'

> Click 'Proofing' then click 'AutoCorrect Options'

> Under 'AutoCorrect' tab uncheck the option 'Capitalize first letter of sentence'

> Under 'Autoformat As You Type' uncheck the option 'Straight quotes with smart quotes'

> 0k

How to find certain word and replace with other?
> Click 'Replace' under 'home' tab or press 'Ctrl + H'
> Type the word to be replaced in 'Find What' box

> Type the new word to use in 'Replace With' box
> Click 'Replace All'

What do you mean by protecting document? What are

different ways of protecting document?

Protecting document means to lock document from modification. To protect document
> Go to 'Review' tab

> Click '"Protect Document'

> Click 'Restrict and Formatting Editing'

> Check 'Allow only this type of editing in this document'

> Select desired option



> Click 'Yes start enforcing protection’

> Type password

> Ok

Different ways of protecting document are

a. Read only: User only can read but can't modifiy anything.

b. Comments: User can insert comment in document

c. Track change: User can insert and delete content from document but can be seen in track
changed form.

d. Filling in form: User can only fill form that is designed in ms word.

What is function of format painter? Explain.
Format painter is used to copy formatting from one text to another.

> Select the text with formatting

> Double click the format painter

> Select another word whose formatting is to be changed.

What is bibliography? How do you add bibliography in ms

word?

A bibliography is a list of all of the sources you have used (whether referenced or not) in the
process of researching your work

To add bibliography

> Go to 'References' tab

> Click 'manage sources' in 'citation and bibliography' section

> Click 'New' and type desired options

> Close

> Then click 'Bibliography' and select the first option

What do you mean by footnote? Write steps to add footnote

to a word in document?

Footnote is an additional piece of information printed at the bottom of a page which explain any
word in document denoted by any number or symbol. To add footnotes to any word

> Click after the word

> Go to 'References' tab

> Under "Footnotes' section click 'insert footnotes'

> Type desired explanatory text below the page

What is the use of mail merge? Write steps to create same
letters to five recepient?

Mail merge is a feature of MS Word that enables users to send a similar letter or document to
multiple recipients. It enables connecting a single letter with a data source that contains
information about the recipient’s name, address and other data.

> Create a data source with related records and save it

> Create new document and type letter

> Under ' Mailing' tab click 'Select Recipients'

> Click 'Use existing list' and open saved data source

> Click 'Insert Merge field' and select desired fields to add in letter

> Click 'Finish and merge'

What is bookmark? How do you add it to document? Write
the ways to hyperlink document



A bookmark is mark added in document that identifies a specific word or location in a
document to identify for future reference

To add bookmark

> Select text

> Insert > Bookmark

> Give bookmark name

> Click 'Add'

To link document

> Select text

> Insert > Hyperlink

> Select a document to link
> 0K

When do you use mirror margin? What are the uses of
header and footer? Write steps to add/insert page number in

document?

Mirror margin is feature of MS word that is used to set up facing pages for double-sided
documents, such as books or magazines. the inside margins are same and the outside margins are
same in mirror margin.

To insert page number

> Place cursor to header or footer to insert page number

> Insert > Page Number > Current Position

> Select desired number style

Write steps to create table of content?

> Apply required heading (heading 1, heading 2, heading 3) to all the headings in document
> References > Table of Contents

> Select desired styles

You have 5 pages. You need to insert one header in page one

and two, another header in other pages. How will you do?

Inserting different header from third page means setting new section from third page
> Click at the beginning of third page

> Page Layout > Break Continuous

> Click on the header part of third page

> Remove highlight to 'Link to Previous' in 'Design' tab

> Now type different header in desired section

Write about Watermark in document

A watermark is a recognizable background image or text that is embedded in a MS
word document. It is used to minimize the illegal copying of original document.
To add watermark

> Page Layout > Water mark > Custom Watermark

To add picture watermark

> Click 'picture watermark'

> Click 'Select picture'

> Select desired picture from computer

> Ok

To add text watermark

> Click 'text watermark'

> Type desired text

> Select desired font, size and color

> Ok



Define header and footer

Section of the page above the top margin is called as header while section of the page below the
bottom margin of the pages is known as footer. Header and footer is used when same text is to
be written at top (header) or bottom (footer) of every page of document.

What is indentation? What are its types?

Indent or indentation is the space between the left and right margin of a paragraph.
types of indent

Left Indent: space between paragraph and left margin

Right Indent: space between paragraph and right margin

First Line Indent: distance from left margin to first line of paragraph

Hanging Indent: distance from left margin to all lines except first line to paragraph

What is margin and gutter margin? What is the use of zoom

in document?

a margin is the area between the main content of a page and the page edges. Margin can be left,
right, top and bottom margin. Gutter margin is extra space left at the left or top of document for
the purpose of binding.

Zoom option in ms word is used to increase or decrease the view percentage of text in
document. It does not change the actual size of text.

What Is Microsoft Excel? Mention features of MS Excel.

Excel is a spreadsheet program which allows us to enter numerical values or data into the rows
or columns of a spreadsheet. it is used to create chart, filter and sort data, use formula etc.
Features of MS excel

- Conditional Formatting

- Pivot Table

- 3d Reference

- Filter and subtotal

- Consolidate

- Paste Special

How Can You Format A Cell? What Are The Options?

Formatting cell changes the look of text or number in cell. To format a cell or cell range select
the cell range, press Ctr + 1 and select desired formatting options

Different formatting options are

General: No specific number format

Number: Specifies the number of decimal places, thousand separator and negative number
format

Currency: Number of decimal places, negative number and currency symbol

Accounting: Number of decimal places and currency symbol

Date: Date format

Time: Time format

Percentage: Displays percentage sign after number and can be specified number of decimal
Places

Fraction: Displays number in fractions

Scientific: Displays number with scientific notation

Text: Any value in the cell is treated as text

Special: Specifies the format for zip code, phone number and security number



Custom: Displays all the number formats
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What do you mean by cell reference? What are its types?

How cell references are useful in calculation?

Cell references is address of cell that is denoted by column name and row number.

Relative references: It is default referencing method. If the position of the cell that contains the
formula changes, the reference is changed

E.g. =A1+BlI

Absolute Reference: If the position of the cell that contains the formula is changed, absolute
reference remains same. Dollar Sign ($) is used to fix row and column

E.g: = $A$1+$BS$1

Mixed reference: It combination of relative and absolute reference. It has either an absolute
column and relative row, or absolute row and relative column. E.g.: =SA1+B§2

Cell references are useful to avoid writing the data again and again for calculating purpose.
Every time a new value added to the cell, the cell will calculate according to the reference cell
formula.

What is chart? Why is it important? List any 5 types of
chart in MS Excel.

Chart: Diagrammatic representation of numeric data is known as chart

Column chart: used to compare values across categories

Line chart: used to display trend ove time

Pie chart: Used to display the contribution of each value to a total

Bar chart: Best chart for comparing values

Area chart: emphasize differences between several sets of data over a period of time
Scatter chart. compares pairs of values

Radar chart: used when the categories are not directly comparable

Define: 3D reference, Data Consolidate

3D reference: A 3D-reference in Excel refers to the same cell or range on multiple worksheets.
It is used to calculate or apply same function or formula in different sheet at one time.

Data Consolidate: it is the function of excel that allows to combine multiple worksheet in one

Write steps

To rename a worksheet

To hide column

To insert new rows

To freeze certain rows and columns

To rename a worksheet

> Right click the sheet tab > Rename
> Type name

> Press Enter

To hide column
> Click the column to hide
> Under 'home' tab > Format > Hide/Unhide > Hide column

To insert new rows
> Click the row below where needed to insert row




> Under 'Home' tab > Insert > Insert sheet rows

To freeze certain rows and columns

> Click to left of the column and below the row to freeze
> Under 'View' tab > Freeze Panes

> Select 'Freeze Panes' option

Define: Filter, Sort, Subtotal

Filter: Feature of MS Excel that is used to display required category of data at a time.
Sort: Sorting means arranging data in ascending or descending order based on number or
alphabets.

Subtotal: Subtotal is feature of MS Excel that returns an aggregate result (sum, min, max,
average) for supplied values of separate category of data separately

A sheet contains roll no, name, address, contact number.

How to sort data based on name of students?
> Select the data

> Data > Sort

> Check 'my data has header’'

> Select 'name' column in 'sort by' option
> OK

What is conditional formatting? How to highlight marks

below 40 with red color in worksheet?

Conditional formatting Specifies the format of value based on specific conditions
To highlight marks below 40 with red color

> Select the cell range

> Home > Conditional formatting

> Highlight Cell rules > Less than

> Type 40 and Select 'red color'

> Ok

What is use of name manager in MS Excel?

Name manager in MS Excel is used to define name to cell range. It is like bookmark. It helps
user to navigate to that position whenever required.

What is data validation? Write steps to allow to enter only

numeric value between 30 and 50.

Data validation is used to restrict the value that can be entered into a cell range
> Select cell range

> Data > Data Validation

> Select 'Whole number' in 'allow' list

> Select 'Between' option under 'data’

> Type 30 in 'minimum’ and 50 in 'maximum’

> 0k

Write about what if analysis.

What-if analysis is the tool in Microsoft Office Excel, using which we can use several different
sets of values in one or more formulas to explore all the various results.

Scenario Manager: Allows to create and save different groups of values or scenarios and switch
between them.



Goal Seek: Used to find the right input for required result
Data Table: used to see the results of many different possible inputs at the same time.

What is PowerPoint?

PowerPoint is the presentation software used to create electronic presentation software.
PowerPoint presentation can be used in education, seminar, training and different places

What are the basic steps to create a presentation?
Basic Steps of creating presentation can be categorized in four groups
1. Slide Layout

> Select a layout

> Type desired text or insert picture

2. Slide Design

> Select desired preset background or set custom background in slide
3. Custom Animation

> Apply animation to text and object in slide

4. Slide Transition

> Set the transition effect to introduce each slide

What is difference between custom animation and slide

transition?

Custom animation is animation effect that is applied to text or object of slide while slide
transition is effect applied to slide. Slide transitions is used to introduce new slide with effect.

What is the use of slide master?

Use of slide master

> To apply same formatting to all slides

> To insert same text or logo or any other object to all slides
> To apply same animation to all slides

What is custom show?

Custom show is defined as presentation within a presentation. It helps to select desired slides
and use them in new presentation without removing other slides.

Why is rehearse time is useful in presentation?

Rehears time is used to set timing for presentation including time for each slide separately. It
helps to estimate total time for presentation.

What is Database Management System (DBMS)? What are

its advantages?

DBMS is a method that stores data, process them and provides the information in an organized
form using database management software. It also allows user to modify, update, organize and
retrieve information from the database

Advantages

= Reduce data redundancy (duplication)
= Increase data consistency (constant nature)
= QGreater data integrity (completeness: complete data can be retrieved)



Improved data security
High storage
Concurrent data access
File Sharing

Time Save

What is table? In how many ways you can create a table in
MS Access 2007?

Table is the primary object of MS-Access. It is the building block of database that stores large
volume of data in the form of rows of columns.

In MS Access 2007 we can create table in 3 ways

Different ways to create a table in ms access database are:

= Creating Table in Design View
= (Creating Table by entering Data
= Creating Table with template (Creating Table by Using Wizard in 2003)

Explain Data, Database and Information.

Data: Data are raw facts which may or may not have meaning.

Database: The collection of organized interrelated data/information to any purpose is known as
database.

Information: Processed data in known as database.

What is RDBMS? Give some examples

Relational Database Management System (RDBMS) is most widely used software or program
that stores database in multiple tables in the basis of a key field. It allows a user to view or create
or retrieve records from multiple linked tables

= MS- Access
Oracle

MS SQL Server
MySQL
Microsoft Access

What are the elements of table?

Elements of table in MS access are

Field

A column of a table which stores a particular type of data is known as a field. It is the smallest
unit of the database. It is also known as attribute.

Record
The collection of multiple related fields which give a complete information of a particular object
or person is known as record. It is also known as tuple.

Define primary key? Why primary key is important?

The special field of table that uniquely identifies each record from database is known as the
primary key of the table. It does not accept duplicate value and cannot be left blank.
Importance of primary key

= To identify each record uniquely
= To control duplication data entry
= To set relationship between tables

What are data types in Access?
Data types in access are
Text: stores alphanumeric value.



Memo: Stores alphanumeric values upto 65535

Number: Stores only number

Date/Time: Stores date and time

Currency: Stores currency value

Auto Number: Generates unique sequential number automatically

Yes/No: Stores logical value that can be only one of two possible values: yes/no, true/false,
on/off etc.

OLE Object: Stores picture, video, sound

Hyperlink: Stores link of other documents

Attachment: Attaches any document or file in the table

Lookup Wizard: Displays data from another table in list box or combo box.

What is query? Write different types of query.

Query is an object of database that is used to view, retrieve, change and analyzed records from a
table or multiple linked tables.

Types of Query

Select Query: Retrieves records from table

Crosstab Query: Presents data in a sheet that summarizes data from the fields in one or more
tables and displays the dynaset (stands for dynamic set) in a datasheet format

Parameter Query: Retrieves data as parameter given and works in conjunction with other types
of queries

SQL Query: Communicates with other types of database

Action Query: Performs action (makes changes) on the data retrieved

followings are action query:
= Update Query: Updates specified value on the table
= Append Query: Adds or appends data from one table to another
= Delete Query: Deletes records from a table or multiple tables.
= Make Table Query: Makes new database table from the result of the query

Define form and report. What are different parts of form

and report?

It is a database object that is used to create an interface for entering data in a table or multiple
tables. A form displays a complete record at a time.
different parts of form are

= Header: Header may be Page header or Form header. Page Header is displayed when the
form is printed and form header is displayed when the form is viewed in the form view.

= Detail: Detail area contains the entire contents of your form design.

= Footer: Footer may be page footer or form footer. Page footer is displayed when the
form is printed and form footer is displayed when the form is viewed in the form view.

Report is a type of access database object that presents data in effective way in a printed format.
It allows a user to print documents according to the user specifications of the summarized
information through queries or tables.

Different parts of report are

= Report Header: Appears at the top of the first page and displays the report title.

= Page Header: Appears at the top of every page and displays the headings (field labels) for
each column.

= Page Footer: Appears at the bottom of every page and displays the page number and total
number of pages.

= Detail Section: Appears between the page header and page footer and displays the records
from the table or query.

= Report Footer: This section is optional. Appears on the last page of the report and
displays summary information such as grand totals.



What is relationship in database? How many types of
relationship are there?

An association among different related tables so that we can retrieve information from different
tables easily.

types of relationship in MS access are:

One to One relationship: In a one-to-one relationship, each record in the first table can have
only one matching record in the second table, and each record in the second table can have only
one matching record in the first table.

" A

One to Many relationship: customer — order

A customer can place any number of orders.
" ]
Many to Many relationship: Actor — Movie
A single actor can play more than one movie. On the other hand, a single movie can have more
than one actor.
To represent a many-to-many relationship, we need create a third table, often called a junction
table, that breaks down the many-to-many relationship into two one-to-many relationships.
Insert the primary key from each of the two tables into the third table.
.
What is database design? What are its type? Write down 4 steps of database design.
Database design is the organisation of data according to a database model
Step 1: Define the Purpose of the Database (Requirement Analysis) Gather the requirements and
define the objective of your database.
Step 2: Gather Data, Organize in tables and Specify the Primary Keys.

Step 3: Create Relationships among Tables.

Step 4: Refine & Normalize the Design.

Write about ER diagram?

An entity-relationship diagram (ERD) is a data modeling technique that graphically illustrates an
information system’s entities and the relationships between those entities. An ERD is a
conceptual and representational model of data used to represent the entity framework
infrastructure.

The elements of an ERD are:

e Entities
¢ Relationships
e Attributes

le.Description: Image result for ER Diagram define

Explain different types of database language.

DDL

Data Definition Language (DDL) statements are used to define the database structure or
schema. Some examples:

o CREATE - to create objects in the database
o ALTER - alters the structure of the database
o DROP - delete objects from the database



DML

Data Manipulation Language (DML) statements are used for managing data within schema
objects. Some examples:

SELECT - retrieve data from the a database

INSERT - insert data into a table

UPDATE - updates existing data within a table

DELETE - deletes all records from a table, the space for the records remain

o O O ©O

DCL

Data Control Language (DCL) statements. Some examples:

o GRANT - gives user's access privileges to database
o REVOKE - withdraw access privileges given with the GRANT command

TCL

Transaction Control (TCL) statements are used to manage the changes made by DML
statements. It allows statements to be grouped together into logical transactions.

o COMMIT - save work done
o SAVEPOINT - identify a point in a transaction to which you can later roll back
o ROLLBACK - restore database to original since the last COMMIT

What is sql join? Explain.
A SQL join combines records from two or more tables in a relational database. A JOIN is a
means for combining fields from two tables (or more) by using values common to each.

Inner join
This type of join is also known as the Equi join. This join returns all the rows from both tables
where there 1s a match.

l».Description: SQL INNER
JOIN

Outer Join
Returns all rows from the table on left or right or both

Left Outer Join: Returns all rows from left table and matching records from right table



le.Description: SQL Right Outer Join: Returns all rows from right table and matching
LEFT JOIN records from left table

l.Description: SQL RIGHT
JOIN

Full Outer Join: returns all
rows from left and right table

|#.Description: SQL FULL
OUTER JOIN

Cross Join: This join combines all the rows from the left table with every row from the right
table. It returns Cartesian product of rows from tables in the join

What is HTML? Write down basic structure of html

document.

HTML stands for Hypertext Markup Language. It is a markup language which determines how
text and other objects are displayed in webpage.

Basic structure of HTML document is

<HTML>

<HEAD> <TITLE> text for title </TITLE> </HEAD>

<BODY>

text to be displayed on webpage goes here....

</BODY>

</HTML>

What are different types of html tags?

There are two types of HTML tags.

a. Paired tag or container tag

Tags that have both opening tag and closing tag are paired tag. eg. <B> </B>, <I> </I>, <A>
</A>

b. Singular tag or standalone tag

Tag that do not have closing tag are singular tag. e.g. <IMG>, <BR>, <HR>, <INPUT>

Give example of ordered list and unordered list in HTML.

Ordered list
An ordered list is a numbered list of items. It starts with <OL> tag



Example

<OL type=1>

<LI> Keyboard </LI>
<LI> Mouse </LI>
<LI> Monitor </LI>
</OL>

Output:

1. Keyboard

2. Mouse

3. Monitor

Unordered List

An unordered list is a bulleted list of item. It starts with <UL> tag
Example

<UL type=disc>

<LI> Keyboard </LI>

<LI> Mouse </LI>

<LI> Monitor </LI>

</UL>

Output:

= Keyboard
= Mouse
= Monitor

Write about formatting tags?

HTML formatting tags used for formatting a text style. HTML Formatting Tags make minor
changes to the formatting of text

Some examples are

Header - <h?> </h?>

There are 6 levels of headings. <h1> is the largest heading while <h6> is smallest.
Bold - <b> </b>

Italic - <i> </i>

Underline - <u> </u>

Strike-out - <strike> </strike>

Preformatted Text - <pre> </pre>

It displays in the browser as it is displayed in a text editor

Small - <small> </small>

Font Size - <tont size="?"> </font>

Change Font Face - <font face="7"> </font>

Centre - <center> </center>

Emphasis - <em> </em>

Used to emphasize text, which usually appears in italics.
Strong Emphasis - <strong> </strong>

Used to emphasize text more, which usually appears in bold.

Why is frame useful in webpage?

HTML frames are used to divide your browser window into multiple sections where each
section can load a separate HTML document. A collection of frames in the browser window is
known as a frameset. The window is divided into frames in a similar way the tables are
organized: into rows and columns.

example

<frameset rows = "10%,80%,10%">

<frame name = "top" src = top_frame.html" />



<frame name = "main" src = main_frame.html" />
<frame name = "bottom" src = bottom_frame.html" />

<noframes>
<body>Your browser does not support frames.</body>
</noframes>

</frameset>

Write down tags for creating following table in HTML.

.
<table border>
<tr>
<th>Name</th>
<th>Post Color</th>
</tr>
<tr>
<td>Ram</td>
<td>0fficer</td>
</tr>
<tr>
<td>Shyam</td>
<td>Operator</td>
</tr>

</table>

What do you understand by CMS? What is its use?

A content management system (CMS) is a software tool that is used to create and manage
content of website or web application
Advantages of using CMS

user-friendliness

quick deployment

ease of maintenance, including updates

cost-efficiency, especially with out-the-box solutions, open source or freeware
extendable functionality, through a large number of plugins and extensions
SEO-friendly features

developer and community support



Example of html form.

<form>

Name: <input type=text> <br>

Address: <textarea> </textarea> <br>

Gender: <input type=radio> Male <input type=radio> Female <br>
Hobby: <input type=checkbox> Singing <input type=checkbox> Dancing <br>
Qualification: <select> <option> SLC </option> </select> <br>
Password: <input type=password> <br>

<input type=submit value=login > <input type=reset value=cancel>
</form>

output:

"]

How Can you include comments in Html?

The comment tag is used to insert comments in the source code. Comments are not displayed
in the browsers. We can use comments to explain code, which can help when we edit the source
code later.

Example of including comment in html:

<!DOCTYPE html>

<html>

<head> <!-- Document Header Starts -->

<title>This is document title</title>

</head> <!-- Document Header Ends -->
<body>
<p>Document content goes here..... </p>
</body>
</html>
Here anything inside <!-- ......................... -->1s not displayed in browser

Write color codes for Black, White, Red, Green and Blue.

What is the use of alt attribute in img tag?
White: FFFFFF

Black: 000000

Red: FF0000

Green: 00FF00

Blue: 0000FF

<img> tag is used in insert image in webpage

Followings are attribute used in <img> tag

src: used to browse image

width: used to set width of image



height: used to set height of image
alt: used to set alternate text for image

What is cell padding and cells pacing?

CELLPADDING sets the amount of space between the contents of the cell and the cell border.
CELLSPACING is the space between the individual cells in the TABLE

e.g.
<table cellspacing="1" cellpadding="1">

What is use of CSS? What is it’s benefits?

CSS is a language that describes the style of an HTML document. CSS describes how HTML
elements should be displayed

Benefit of using CSS

1. Search Engine Optimization

2. Browser Compatibility

3. Appearance

4. Maintainability

5. Bandwidth Savings

How do you display text in browser without any formatting

<pre> tag is used to display text in browser without formatting
example

<!DOCTYPE html>

<html>

<head>
<title>HTML pre Tag</title>

</head>

<body>
<pre>
I am a student.
I am learning html.
it's very interesting
</pre>

</body>

</html>



This will produce the following result —

I am a student.
I am learning html.

it's very interesting



